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What is Accessibility?
AN OVERVIEW OF WEB ACCESSIBILITY & PEOPLE WITH DISABILITIES
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Question:
What comes to mind when you hear the word accessibility?

How have you dealt with accessibility in your work?
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Quote:
The power of the Web is in its universality.  Access by 
everyone regardless of disability is an essential 
aspect.

- Tim Berners-Lee, W3C Director and inventor of the world wide web
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Accessibility Defined
"Accessible" means a person with a disability is afforded 
the opportunity to acquire the same information, engage 
in the same interactions, and enjoy the same services as a 
person without a disability in an equally effective and 
equally integrated manner, with substantially equivalent 
ease of use. The person with a disability must be able to 
obtain the information as fully, equally and independently 
as a person without a disability…" 
Source: Resolution Agreement South Carolina Technical College System OCR Compliance Review No. 
11-11-600 - Department of Justice and the Department of Education's Office for Civil Rights
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What is Digital Accessibility?
Practice of making websites, mobile applications, 
documents, emails and any other electronic information 
technology (EIT) usable by people with disabilities
Goal is to ensure equal access to information and functional 
for everyone
Ensuring content work with the tools that people with 
disabilities use

5/4/2017 © 2017 INTERACTIVE ACCESSIBILITY - PRIVATE AND CONFIDENTIAL 8



Accessible Content
Accessible if all users can access the information that 
they need
Usable by people who have visual, auditory, 
mobility, and cognitive disabilities
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20% of the US Population has a Disability

Source: US 2010 Census.
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Prevalence by 
Age (U.S. 
Statistics)
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U.S. Breakdown
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Source: Centers for Disease Control and Prevention 2015



57% of 
Computer 
Users Benefit
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Accessibility Helps Everyone!
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People with Disabilities 
and the Web
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Having a Disability is not Disabling
Assistive technologies have been developed to 
assist those with disabilities in leading 
productive lives
Work with everything on the computer
Can translate information into readable, 
understandable content on the desktop, web, 
mobile devices and much more!
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Types of Disabilities
Blind
Low-vision
Color Blind
Mobility Impaired
Deaf and Hard-of-hearing
Cognitive / Learning Disability

5/4/2017 © 2017 INTERACTIVE ACCESSIBILITY - PRIVATE AND CONFIDENTIAL 17



Gabi
Use tools to produce an 
auditory version of the digital 
media called screen readers
◦Available both on the PC and 

the Mac (mobile, too!)
Some users use refreshable 
Braille devices
Screen readers rely on well 
structured and valid code
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What is a Screen Reader?
A software program that produces an auditory 
version of what a visual user sees on the screen
◦Reads text
◦Announces links, buttons, and other controls
◦Reads descriptions of images (if provided)
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What do screen readers do?
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JAWS Demo: Meet Jason

https://www.youtube.com/watch?v=q_ATY9gimOM
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Jeremy and his Guide Dog Darren
Use tools and browser 
functions to magnify the 
screen called screen 
magnifiers
Sometime use a screen reader 
with the screen magnifier
May use alternative 
stylesheets to make text 
easier to read
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Screen Magnifiers
Provide the following functions:
◦Screen magnification
◦Change the mouse cursor
◦Customize focus indicators
◦Change the color schemes
◦Can also read text on the screen
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ZoomText Demo: Meet Sameer Doshi 

https://www.youtube.com/watch?v=VBeu01ztoZE
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Julie
Cannot hear audio 
content in multimedia
Auditory cues will be 
missed
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Shawn
Use alternative methods for input
Can use
◦Tools which mimic the mouse
◦Speech recognition software
◦Head wand

Often rely on the keyboard alone

5/4/2017 © 2017 INTERACTIVE ACCESSIBILITY - PRIVATE AND CONFIDENTIAL 26



Sara, Eric, Jonathan
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Assistive Technologies for Learning 
Impairments
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Literacy software
◦Highlight text as it is read to user
◦Provide in-context definitions
◦Remove clutter from a Web page to concentrate on 
one part at a time
◦Use more readable fonts



Rules and Regulations
WHAT IS REQUIRED IN THE UNITED STATES? 
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Section 504 and ADA Title II
No otherwise qualified individual with a 
disability in the United States…shall, solely by 
reason of her or his disability, be excluded from 
the participation in, be denied the benefits of, 
or be subjected to discrimination under any 
program or activity receiving Federal financial 
assistance…
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Accessibility Standards
Section 508
WCAG 2.0 Level AA

(Web Content Accessibility Guidelines)

At this point they basically both require the 
same things
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W3C WCAG 2.0
Focuses on user needs
Independent of technology

Make text readable and 
understandable
Make content appear and operate in 
predictable ways
Help users avoid and correct 
mistakes
Give users enough time to read and 
use content
Help users navigate and find content
Make all functionality available from 
a keyboard
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Levels of WCAG 2.0 Conformance
Level A conformance corresponds to the most 
basic requirements for displaying Web content
Level AA conformance provides for a stronger 
level of accessibility
Level AAA conformance comprises the highest 
level of accessibility within the WCAG guidelines
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WCAG Applies to …
Web-based sites and applications
Documents
Mobile sites & native applications
All digital communications & programs
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Planning for People 
With Disabilities
DOCUMENT STRUCTURE, IMAGES, CHARTS, COLOR, FORMS, 
INTERACTIVE COMPONENTS
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Document Structure
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Visual information is presented to all 
users
Headings
Lists
Page sections
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Identifying 
Headings
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Identifying 
Headings
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Visually, we see where 
each section of the page 
is because of
◦ Changes in fonts
◦ Changes in colors
◦Use of whitespace



What do screen 
readers see?
This page contains some 
heading markup, so 
screen readers can 
understand where 
headings are and how 
important they are
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What do screen 
readers see?
Screen reader users can 
access a heading outline 
to understand the 
structure
It is a way they can skim 
the page for content
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Understanding Lists
Identifies items as lists
◦ Tells users how may items 

are in a list
◦Allows easy navigation 

between list items
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Understanding 
sections of the page
We can easily identify 
the
◦Header
◦Main content
◦Navigational areas

Can screen reader users 
understand these 
sections too?
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Setting Styles in WordPress
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Images
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Alternative Text on the Web
Every image must have an alt attribute
Some images are

Functional (click on them)
Informational
Decorative
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How Text Alternatives Are Used
Provides equivalent information for users who 
cannot access the information in the image
◦Screen readers use this to communicate the meaning or 
function of the image for those who cannot see the 
screen
◦Speech to text applications such as Dragon Naturally 
Speaking use this to identify what element the user is 
talking about
─“Click Go”
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Tips For Writing Good Alternative Text
Ask

“What message am I trying to convey?”
“What function does this image play?”

If the description is over 100-125 characters (20-30 
words) reconsider your approach
Many alt attributes are significantly shorter (3-8 words)
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Things to avoid with alt text
Don't use verbs like "click here to", "go", or 
"return"
Don't include words like "image of", "graphic", 
or "link to"
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Informational 
Images
Does this image convey 
information that needs alt 
text?

alt="No Bullying: hitting, 
Cyber bullying, gossiping, 
pushing, rumors, lies, 
name calling, teasing, 
mean words, threats"
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Functional Images
What will screen readers 
hear?

5/4/2017 © 2017 INTERACTIVE ACCESSIBILITY - PRIVATE AND CONFIDENTIAL 51



Only get partial 
descriptions

alt="Printing Services"

alt="Having a Problem at 
School? Bullying Hotline: 
215-400-7233"
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Decorative Images
These images only add 
visual interest and don't 
convey significant 
information
They can be ignored by 
screen readers
Use alt=""
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Images of Text
Images of text cause problems because of pixelization when 
zoomed in
Images of text can only be used for logos
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Adding alt text in WordPress
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Code editor

Media Library



Graphs and Charts
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Graphical representation of data
How does a blind 
user understand 
this information?
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Providing the information in another way
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Color

5/4/2017 © 2017 INTERACTIVE ACCESSIBILITY - PRIVATE AND CONFIDENTIAL 59



Question to ask about color accessibility
Given moderate visual acuity loss, can a person 
read this content without the aid of assistive 
technologies?

WCAG 2.0 defines formulas for determining 
color combinations that have sufficient contrast
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Which parts of the 
screen have 
contrast problems?
Some problems will be 
more obvious
Some will be difficult to 
determine without testing 
tools

Bottom line: Don't trust 
your own eyes to 
determine pass/fail
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What passes and 
what fails
Only the highlighted text 
has sufficient contrast 
with the background 
colors
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Forms
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What information 
goes in each input?
Which one is the first 
name and which one is 
the last name?
Which fields are 
required?
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Will errors be 
apparent to users?

5/4/2017 © 2017 INTERACTIVE ACCESSIBILITY - PRIVATE AND CONFIDENTIAL 65



Interactive Components
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Interacting with 
content
Can users interact with 
these custom 
components?
Cant they change the 
slides?
Can they pause and 
change the rotating 
headline?
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Notifications of 
updates
Keyboard users and 
screen reader users can 
get to these controls
But some screen reader 
users will not know what 
their function it
Screen reader users won't 
know that something 
changed after clicking an 
arrow button
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Keyboard access
Mouse users can rotate 
the contents
But keyboard users 
cannot get to the 
controls to rotate the 
message
There is also no way to 
pause the message
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Video Accessibility
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Three aspects
Captioning
Audio Description
Accessibility of the Player
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Captions
Captions present spoken 
text and other significant 
sounds from the video
◦Dialog (including who is 
speaking)
◦Non-speech information 
("door slams", "music 
playing")
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Creating Captions
It requires a human creating the transcript of 
the text
Machine-generated captions contain too many 
errors
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Which is it?
Is this a cosine or a cosign?
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Audio Description
Describes what is happening in the video for those who 
cannot see the video
Add an extra audio track describing the significant 
information being conveyed

"Tiny droplets of water trickle down its surface 
forming one large drop"

http://main.wgbh.org/wgbh/pages/mag/description.html

http://main.wgbh.org/wgbh/pages/mag/description.html


Audio Description Strategy
Avoid the need for audio description
◦Describe what is happening in the video while it is happening

Image from Mehran Moghtadai and Wikipedia Commons 

Incorrect: “Look what happens when a 
tube enters the liquid.”

Correct: “Where a green tube enters some 
glass containers, the tube appears to be 
broken and appears to start over again from a 
little ways away. The same thing appears to 
happen again, inside the glasses, as the green 
tube enters either liquid. "

http://en.wikipedia.org/wiki/File:Glass_is_Liquide.jpg


Video Player Accessibility
Can a non-mouse user 
control the video?
◦Play
◦Pause
◦Adjust volume
◦Change the time position
◦Turn on captions

5/4/2017 © 2017 INTERACTIVE ACCESSIBILITY - PRIVATE AND CONFIDENTIAL 77



Accessible Documents
BEST PRACTICES, TIPS,  AND TECHNIQUES FOR ACCESSIBILITY
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Goals
Look at the most common tools: Word and PowerPoint
Consider design for accessibility
◦A format or style might be inaccessible
◦ It might require more work to make accessible 
◦ It could be more complicated for all users
How to make most documents accessible with minimal 
effort
Summary of additional steps for PDFs
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Microsoft Word
Versions 2013 or 2016 produce best results
Use the built-in accessibility checker on the File menu
Main take-away points
◦ Use styles!   It is easy and powerful and….   stylish? (to Word geeks)
◦ Add alternative text to images and make their wrap style in-line
◦ Never fake it!  Use the built-in features to make it:
─ Lists
─ Headings
─ Links (by default it autocorrects to create them)
─ Tables
─ Multiple columns
─ Footnotes / endnotes

Generate PDF with bookmarks, TOC links, properties and accessibility tags
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Check Design and Adjust
Color contrast
Using color alone for meaning
Font size
Font style
Table design
Simulating rather than using built-in features
Avoid images of text
Page header/footer is ignored by screen readers
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Color Contrast
Meet the requirements described earlier
Look for text that is harder to read, 
especially if small
Difficult color combinations
◦Orange/white
◦Yellow/white
◦Light blue/white
◦Gray/white
◦Pastels

Orange/white

Orange/white

Blue/white

Blue/white

Gray/white

Yellow/white

Gray/white

Yellow/white

Good Blue

Good Gray

Good Yellow?

Good Orange?
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Color Alone
Don’t use color by itself to 
convey meaning
Color is ok, just use something 
else as well

Schools in red are participating:

Adaire, Alexander School
Alcorn, James School
Allen, Dr. Ethel School
Allen, Ethan School
Amy 5 At James Martin
Amy Northwest
Anderson, Add B. School
Arthur, Chester A. School
Bache-Martin School *
Baldi, C. C. A. Middle School
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Font Size
Try to use 10 to 12 depending on the font
It should be easy to read
◦Small can be difficult for all users, particularly those 
with low vision

◦ Small text is hard
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Font Style
Use fonts that are easy to read 
and clear, such as:
◦ Calibri
◦ (not in default Windows)
◦ Tahoma
◦ Verdana
◦ Times New Roman

Note: all but Helvetica are 24 point here

Avoid hard-to-read or artistic 
fonts:

Note: these may not come over well to PDF as real text, either
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Tables Headers
They should have header 
cells top and/or left
Should repeat across 
pages

Avoid This Do This
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Table Rows Don’t Span Page Breaks
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Keep Tables Simple
If possible, avoid:
◦Multiple levels of header cells with merged cells
◦Merged rows dividing table into sections
◦Merged header cells on left
◦Table titles and other information inside the table
◦Footnotes from header cells – can you put the note 
before the table?

Always avoid merged data cells
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Simple Table Examples
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Table with Title and Footnote * Inside

This simplifies reading in Word and in the PDF, which must otherwise be altered so that the 
table is announced correctly and the footnote is ready properly by screen readers.
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Complex Table
Allowed, but harder for screen reader users
Not as good support for reading in Word
Leads to much more work in PDF than simple tables
Would it be possible to split into multiple tables and simplify?
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Avoid These
Empty paragraphs 
from pressing 
enter – use space 
before/after
Fake bullets and 
lists instead of 
using built-in 
styles
Simulating 
multiple columns
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Fix List
Remove any manually 
entered bullets (fakes)
Highlight list and select 
list tool or a list style
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Fix Simulated Multiple Columns
Select text then Layout > 
Columns
Use Layout > Breaks > Page > 
Column to force to text to top 
of next column
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Fix Indentation by tab or spaces
Remove indentation 
spaces or tabs
Adjust ruler or Paragraph 
> Indentation
You could even make a 
new style to save time 
later
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Avoid Images of Text

It is just a picture. 
The text cannot be 
read by a screen 
reader
It magnifies poorly
Is there another 
way to present?
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Steps in Word
Check design and modify as appropriate – DONE
Add document properties
Use styles
Verify headings
Add image with alt text
Run accessibility checker
Create PDF
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Add Document Properties
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Use Styles
They make your editing much easier
Faster than direct formatting (using the toolbar)
Allow you to format all similar types of content together
Shortcut keys make them fast to use, especially for headings
You can set it up once and save to a template for your group
Easy to modify later – “I want all my level 2 headings to be 
dark blue, bold, and a bit bigger”.  No problem, just a few 
clicks.
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Define or Update a Style
Right click > Edit on 
Styles toolbar or 
select edit on right
Format style
Assign shortcut key if 
you want under 
Format
Apply style to text
◦Place cursor on line
◦Select heading style
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Or: Update Style to Match Text
Format text using direct formatting
Select it
Right click the style or select 
dropdown on right
“Update Heading 2 to match 
selection” (or whatever style you 
picked)
Also assigns that style to the text at 
the same time
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Verify Headings
Heading represent the 
document structure
Table of Contents is a useful 
guide to the structure, if 
present
If it looks like a heading, should 
it be one? If so, apply a heading 
style
You would override formatting 
for some text in this heading
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Table of Contents for Headings
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Use one Heading 1
Make the document title the single use 
of Heading 1
Use the built-in heading 1 style. Don’t 
make a new one
Make next major headings level 2
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Add Images
Insert > Pictures
Select wrap style “in line” for 
proper reading order
“With text wrapping” causes 
problems with reading order

OR
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Add Alternative Text
Text that conveys the information 
equivalent to the picture
Right click > Format on the picture > 
Size and position > Description
Usually, use the exact text of the 
image for logos
◦ Avoid describing as logo, seal, photo of, 

image of, etc.
◦ Screen reader will tell user it is an 

image
◦ “School Reform Commission. The 

School District of Philadelphia, PA”
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Accessibility Checker
File > Inspect
Correct errors
Consider warnings

5/4/2017 © 2017 INTERACTIVE ACCESSIBILITY - PRIVATE AND CONFIDENTIAL 107



Produce PDF
Depending on version:
◦File > Export as PDF
◦File > Save as PDF
◦On ribbon, PDF Maker, if installed with Acrobat
Do not print to PDF – inaccessible
Check Options settings
◦Properties
◦Bookmarks
◦Accessibility tags
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PowerPoint
Similar to Word in many ways described
Make user of Master Slide layouts and save as a 
template
Use content placeholders in layouts, not 
textboxes
Check reading order in selection pane

5/4/2017 © 2017 INTERACTIVE ACCESSIBILITY - PRIVATE AND CONFIDENTIAL 109



Layouts
Consider how content should be laid out
Using default layouts or only slightly 
modifying is simplest
Do not put content meant to be read on 
master – it is ignored.
◦Repeating logos and copyright, etc. are fine 

but should appear at least once on a regular 
slide so they are read.

Set the proper reading order of elements in 
the layout (details later)
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Images
Add alternative text
After adding images, check and adjust the 
reading order
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Reading Order
Shown in Selection Pane
Is from bottom to top of the list
◦ Footer
◦ Images in appropriate order
◦ Content placeholders
◦ Title
Move elements up/down as 
necessary
Re-check after adding images
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Accessibility Checker
Same as in Word
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Produce PDF
Same as in Word
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PDF Steps
The work you have done in Word and PowerPoint make a 
generated PDF mostly accessible 
Most screen reader users will be able to successfully read and 
interact with your content and many would consider it 80-
90% accessible
Need more steps in Acrobat to complete the PDF remediation 
◦Are technical in nature
◦Require Acrobat Professional
◦ They are summarized here for your information but this is not a 

tutorial
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Document Properties
Verify/adjust title, author, 
subject, keywords
Verify “tagged PDF”
Enable screen reader access if 
security is enabled
Document title shown in window 
title
Reading language set 
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Tab Order
Set to Document Structure
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Content Reading Order
Verify the Order pane reading order – adjust as 
necessary
Look for empty paragraphs and remove
Check for content that should be ignored by 
screen readers
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Example of Order Pane
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Check Tags

Order – for screen readers
Types of tags used
Alt text and images to be ignored
Heading structure
Correct tagging of lists, tables, links, etc.
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Example of Tags

5/4/2017 © 2017 INTERACTIVE ACCESSIBILITY - PRIVATE AND CONFIDENTIAL 121



Accessibility Checker
Checks against Section 
508 and WCAG 2.0 AA 
guidelines
Correct Issues
Verify proper reading 
with a screen reader
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Questions?
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Thank you!

Greg Kraus

Steve Wahlbin
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